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1 НАЗНАЧЕНИЕ ПАКЕТА SIMULINK 

Пакет расширения Simulink системы MATLAB является ядром инте-
рактивного программного комплекса, предназначенного для математическо-
го моделирования линейных и нелинейных динамических систем и уст-
ройств, представленных своей функциональной блок-схемой. 

Для построения функциональной блок-схемы моделируемых устройств 
Simulink имеет обширную библиотеку блочных компонентов и редактор 
блок-схем. Он основан на графическом интерфейсе пользователя и по суще-
ству является средством визуально-ориентированного программирования. 
Используя палитры компонентов (наборы блоков), пользователь с помощью 
мыши переносит нужные блоки с палитр на рабочий стол пакета Simulink и 
соединяет линиями входы и выходы блоков. Таким образом, создается диа-
грамма (блок-схема) системы или устройства, то есть модель. Модель факти-
чески является программой, которую можно просмотреть с помощью тесто-
вого редактора или с помощью редактора файлов системы MATLAB. Файлы 
модели имеют расширение .mdl. 

Ценность Simulink заключается и в обширной библиотеке компонентов 
(блоков). Она включает источники воздействий (сигналов) с практически 
любыми временными зависимостями, масштабирующие, линейные и нели-
нейные преобразователи с разнообразными формами передаточных характе-
ристик, квантующее устройство, интегрирующие и дифференцирующие бло-
ки и т. д. 

В библиотеке имеется целый набор виртуальных регистрирующих уст-
ройств – от простых измерителей типа вольтметра или амперметра до уни-
версальных осциллографов, позволяющих просматривать временные зависи-
мости выходных параметров моделируемых систем, например токов и на-
пряжений, перемещений, давлений и т.п. В дополнительных библиотеках 
присутствуют анализаторы спектра сложных сигналов, многоканальные са-
мописцы и средства анимации графиков. 

Средства графической анимации Simulink позволяют строить вирту-
альные физические лаборатории с наглядным представлением результатов 
моделирования. Возможности Simulink охватывают задачи математического 
моделирования сложных динамических систем в физике, электро- и радио-
технике, в биологии и химии – словом, во всех областях науки и техники. 
 

2 ЗАПУСК SIMULINK И ОСНОВЫ РАБОТЫ С ПАКЕТОМ 

2.1 Запуск пакета Simulink 

После инсталляции Simulink (отдельно от MATLAB или в его составе) 
он автоматически интегрируется с MATLAB. Внешне это выражается появ-
лением кнопки Simulink  в панели инструментов системы MATLAB. При 
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нажатии этой кнопки открывается окно интегрированного браузера библио-
тек (рисунок 1). 

Simulink также можно запустить, выполнив в командной строке 
MATLAB команду 
>> simulink 

 
Рисунок 1 — Окно браузера библиотек Simulink 

В окне браузера содержится дерево компонентов библиотек Simulink. 
Для просмотра того или иного раздела библиотеки достаточно выделить его 
мышью – в правой части окна «Simulink Browser Library» появится набор 
пиктограмм компонентов активного раздела библиотеки. 

С помощью меню браузера или кнопок его панели инструментов мож-
но открыть окно для создания новой модели или загрузить существующую. 
Работа с Simulink происходит на фоне открытого окна системы MATLAB, в 
котором нередко можно наблюдать за выполняемыми операциями — если их 
вывод предусмотрен программой моделирования. 

2.2 Установка параметров моделирования 

Для настройки параметров моделирования используется команда меню 
«Simulation ⇒ Simulation Parameters…». После ее выполнения появляется ок-
но установки параметров моделирования, имеющее ряд вкладок с довольно 
большим числом параметров. Наиболее важной является вкладка, открывае-
мая по умолчанию, – «Solver» (Решатель). Эта вкладка позволяет установить 
параметры решающего устройства системы моделирования Simulink. К числу 
важнейших параметров решателя относится время моделирования — «Simu-
lation time». Время моделирования определяет собственное время модели, в 
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течение которого выполняется моделирование и не имеет отношения к ре-
альному времени, затрачиваемому на моделирование. Оно задается началь-
ным временем «Start time» (обычно 0) и конечным временем «Stop time» (по 
умолчанию 10). В качестве конечного времени может быть установлена бес-
конечность (inf). Равенство «Stop time» бесконечности означает, что модели-
рование будет происходить бесконечно долго, пока мы не прервем его. Од-
нако в этом случае трудно получить различимые осциллограммы работы уст-
ройства, поэтому в большинстве случаев удобнее задавать конечные значе-
ния «Stop time». 

Первостепенное значение имеют две опции решателя в поле «Solver op-
tions»: тип решения «Type» и метод решения «Solver». Возможны два типа 
решения: 

− «Variable-step» — решение с переменным шагом; 
− «Fixed-step» — решение с фиксированным шагом. 
Как правило, лучшие результаты дает решение с переменным шагом. В 

этом случае шаг автоматически уменьшается, если скорость изменения ре-
зультатов в процессе решения возрастает. И напротив, если результаты ме-
няются слабо, шаг решения автоматически увеличивается. Это исключает 
(опять-таки, как правило) расхождение решения, которое нередко случается 
при фиксированном шаге. 

Метод с фиксированным шагом обычно стоит применять только тогда, 
когда фиксированный шаг обусловлен спецификой решения задачи, напри-
мер, если ее цель заключается в получении таблицы результатов с фиксиро-
ванным шагом. Этот метод дает неплохие результаты, если поведение систе-
мы описывается почти монотонными функциями. В противном случае шаг 
времени придется сильно уменьшать для описания наиболее быстрых участ-
ков изменения результатов моделирования, что ведет за собой значительное 
возрастание времени моделирования. 

Вторая из указанных опций — выбор метода моделирования, определя-
ет величину и изменение шага в процессе моделирования. Выбор метода мо-
делирования может оказывать решающее влияние на результаты моделиро-
вания. 

Следующие три параметра обычно задаются автоматически (значения 
опций «auto»), но в особых случаях их можно ввести явно: 

− «Max step size» — максимальный шаг моделирования (автоматиче-
ское значение равно: для дискретного решателя наименьшее значение «Sam-
ple time», для непрерывного решателя, если «Stop time» равно «inf», то 0.2, 
иначе (Stop time – Start time)/50); 

− «Min step size» — минимальный шаг интегрирования; 
− «Initial step size» — начальный шаг интегрирования. 
Важен и такой параметр моделирования, как точность моделирования: 
− «Relative tolerance» — относительная погрешность моделирования; 
− «Absolute tolerance» — абсолютная погрешность моделирования. 
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По умолчанию они заданы, соответственно, равными 10–3 и 10–6. Если, 
например, графики результатов моделирования выглядят составленными яв-
но из отдельных фрагментов, это указывает на необходимость уменьшения 
указанных значений погрешности. Однако слишком малые погрешности мо-
гут вызвать значительное увеличение времени вычислений. Не оптимально 
выбранные значения погрешности (как очень малые, так и очень большие) 
могут вызвать неустойчивость и даже «зацикливание» процесса моделирова-
ния. 

2.3 Моделирование простого устройства 

Рассмотрим задачу моделирования работы идеального ограничителя 
сигналов, на вход которого подается синусоидальное напряжение с амплиту-
дой 5 В и частотой 1 рад/c. Допустим, что пороги ограничения составят +0,5 
и –0,5 В. В данном случае очевидно, что основными блоками будут генератор 
синусоидальных сигналов и блок нелинейности, моделирующий передаточ-
ную характеристику ограничителя. Кроме того, к этим блокам надо добавить 
регистрирующий блок – осциллограф. 

 
Для создания модели данного устройства выполните перечисленные 

ниже действия: 
а) откройте окно новой модели командой меню «File ⇒ New ⇒ Model» 

(кнопка «Create a new model»  на панели инструментов). 
б) из раздела библиотеки «Simulink ⇒ Sources» перенесите в окно мо-

дели источник синусоидального сигнала «Sine Wave». 
в) из раздела библиотеки «Simulink ⇒ Discontinuities» перенесите в ок-

но модели нелинейный блок – ограничитель «Saturation». 
г) из раздела библиотеки «Simulink ⇒ Sinks» перенесите в окно модели 

блок осциллографа «Scope». 
д) выполните соединение между блоками «Sine Wave» – «Saturation» и 

«Saturation» – «Scope». Для этого укажите курсором мыши на выход блока 
источника и затем при нажатой левой кнопке мыши протяните соединение на 
вход блока назначения (или наоборот). При первом соединении появляется 
окно, поясняющее способ облегчения соединения с помощью клавиши Ctrl: 
Выделите блок(и) источника, нажмите клавишу «Ctrl» и щелкните левой 
кнопкой на блоке назначения. 

е) установите время моделирования: «Start time = 0» и «Stop time = 20». 
Для этого откройте окно параметров моделирования командой меню «Simu-
lation ⇒ Configuration parameters …». 

ж) щелкните дважды левой кнопкой мыши по блоку «Sine Wave» и в 
появившемся окне параметров источника синусоидального сигнала устано-
вите амплитуду равной 5. 

з) запустите модель на исполнение, нажав кнопку «Start Simulation»  
в панели инструментов окна модели (команда меню ««Simulation ⇒ Start»). 
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и) откройте осциллограф, дважды щелкнув левой кнопкой мыши по 
блоку «Scope». 

Результат моделирования приведен на рисунке 2. 
Нетрудно заметить, что масштаб отображения осциллограммы у ос-

циллографа оказался не совсем удачным – изображение осциллограммы мало 
по высоте, поскольку при порогах в 0,5 масштаб в 5 условных единиц уровня 
получается слишком крупным. 

Для смены масштаба щелкните правой кнопкой мыши в окне осцилло-
граммы. В появившемся контекстном меню выберите пункт «Axes 
Properties…». В открывшемся окне свойств осей замените значения Y-min=-5 
и Y-max=5, например, на Y-min=-1 и Y-max=1. 

В контекстном меню осциллограммы есть также пункт «Autoscale» 
(Автомасштабирование), устанавливающий масштаб, при котором окно ос-
циллограммы используется полностью. Эта же команда реализуется кнопкой 
«Autoscale»  панели инструментов окна осциллограммы. 

 
Рисунок 2 — Простая модель и результаты ее моделирования 

Усложним модель, подключив к источнику синусоидального сигнала 
нелинейность типа «мертвая зона» и релейный пороговый элемент (в элек-
тронике известный под именем триггера Шмитта), каждый с собственным 
осциллографом. Для этого: 

а) из раздела библиотеки «Simulink ⇒ Discontinuities» перенесите в ок-
но модели нелинейный блок типа «мертвая зона» «Dead Zone». 

б) щелкните дважды левой кнопкой мыши по блоку «Dead Zone» и в 
появившемся окне установите границы мертвой зоны Start dead zone = -2 и 
End dead zone = 2. 



9 
 

в) из раздела библиотеки «Simulink ⇒ Discontinuities» перенесите в ок-
но модели нелинейный блок типа релейный пороговый элемент «Relay». 

г) сделайте отвод от линии, соединяющей блоки «Sine Wave» и «Satura-
tion» до блоков «Dead Zone» и «Relay». Для этого укажите курсором мыши 
на вход блока назначения и затем при нажатой левой кнопке мыши протяни-
те соединение до линии, от которой хотите выполнить отвод. 

д) выделите блок осциллографа «Scope» и скопируйте его в буфер об-
мена. 

е) дважды вставьте блок осциллографа из буфера обмена. 
ж) подключите осциллографы к выходу блоков «Dead Zone» и «Relay». 
з) откройте осциллографы, дважды щелкнув по ним левой кнопкой 

мыши. 
и) для осциллографа, подключенного к блоку «Relay», установите мас-

штаб по оси Y в диапазоне от -1 до 2. 
к) запустите модель на исполнение. 
л) для осциллографа, подключенного к блоку «Dead Zone», включите 

автомасштабирование. 
Результат моделирования приведен на рисунке 3. 

 
Рисунок 3 — Усложненная модель и результаты ее моделирования 
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Таблица 1 – Блоки раздела библиотеки «Sources» 
Блок Описание 

 

Задает константу или вектор констант (в квадратных скобках, например, 
[-1 0 1 2 3.14]) в различных выходных форматах 

 

Источник синусоидального сигнала. Параметр Sample time в этом и дру-
гих блоках (где этот параметр присутствует) задает интервал времени 
между отсчетами (0 — непрерывное время; –1 — унаследование значе-
ния Sample time от блока, подключенного к его входу или выходу) 

 

Источник линейно нарастающего воздействия вида 
F(t) = Slope ⋅ t + Initial value 

 

Источник воздействия в виде одиночного перепада. 
Параметры: Step time – время появления перепада (скачка); Initial 
value – начальное значение воздействия (до перепада); Final value – ко-
нечное значение воздействия (после перепада) 

 

Источник прямоугольных импульсов. 
Параметры: Amplitude – амплитуда; Period – период; Pulse width – ши-
рина импульсов (в процентах от периода); Phase delay – задержка до на-
чала генерирования импульсов 

 

Источник случайного сигнала с нормальным распределением. 
Параметры: Mean – среднее значение; Variance – среднеквадратическое 
отклонение; Initial seed – начальный параметр генератора псевдослучай-
ных чисел 

 

Источник случайного сигнала с равномерным распределением. Уровень 
сигнала ограничен сверху и снизу значениями Maximum и Minimum 

 

Источник служит для генерации повторяющейся последовательности, 
заданной векторами моментов времени (Time values) и значений сигнала 
в эти моменты времени (Output values). Узловые точки сигнала, задан-
ные этими векторами, соединяются отрезками прямых, то есть между 
ними задается линейная интерполяция. По умолчанию формируется пи-
лообразный сигнал 

 

Источник служит для генерации повторяющейся последовательности 
прямоугольных импульсов, заданной вектором амплитуд 

 

Генератор нарастающей частоты — создает почти синусоидальные коле-
бания, частота которых увеличивается до некоторого момента времени 

 

Конструктор сигналов позволяет задавать на выходе порта/портов 
один/несколько выходных непериодических сигналов, форму которых 
можно задать с помощью диалогового окна 

 
Блок для получения данных из внешнего файла 

 

Блок для получения данных из рабочего пространства MATLAB 

 
Блок для получения текущего времени модели 
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Таблица 2 – Блоки раздела библиотеки «Sinks» 
Блок Описание 

 

Одно/многоканальный осциллограф. Параметры (кнопка «Parameters» 

 панели инструментов окна осциллографа): 
− Number of axes – число каналов осциллографа; 
− Time range – ширина временного интервала; 
− Tick labels – вывод/скрытие отметок по осям; 
− Sampling – частота снятия отсчетов во времени (Decimation – крат-
ность вывода данных, по умолчанию 1, или Simple Time – в секундах 
эталонного времени); 
− Floating Scope – перевод осциллографа в «плавающий» режим 

 

Плавающий осциллограф. Не имеет заданных в явном виде входов. 
Чтобы выбрать показываемый каналом сигнал необходимо выделить 
левой кнопкой мышки соответствующий график канала и выбрать сиг-

нал в диалоговом окне, вызываемом кнопкой «Signal Selection»  па-
нели инструментов или аналогичной командой из контекстного меню 

 

Графопостроитель – имеет входы по осям X и Y, что позволяет строить 
графики функций в полярной системе координат, фигуры Лиссажу, фа-
зовые портреты и т.д. Подавая на вход X графопостроителя линейно 
нарастающий сигнал времени можно получить из графопостроителя 
осциллограф 

 
Блок заглушка, для подключения «висящих» выводов, вызывающих 
ошибку моделирования 

 

Виртуальный дисплей – устройство представления информации в циф-
ровом виде. Дисплей обеспечивает динамическое отображение данных, 
позволяя наблюдать их изменение в процессе моделирования. Дис-
плей, как и осциллограф, может быть сделан плавающим 

 

Блок сохранения данных в файле 

 

Блок сохранения данных в рабочем пространстве MATLAB 

 

Блок остановки моделирования, обеспечивающий прерывание модели-
рования и его остановку, если на его вход поступает сигнал, не равный 
нулю 

Таблица 3 – Блоки раздела библиотеки «Signal Routing» 

Блок Описание 

 

Блок создания шины служит для объединения двух и более сигналов раз-
личного вида в одну шину. Сигнал из шины извлекается с помощью 
шинного селектора. Через некоторые блоки, например переключатель 
сигналов, шина может проходить без изменений, в остальных случаях 
будет выполнено мультиплексирование сигналов шины (смотри блок 
мультиплексирования) 

 

Блок шинного селектора обеспечивает выбор заданных сигналов из ши-
ны 
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Продолжение таблицы 3 
Блок Описание 

 

Блок мультиплексирования объединяет входные сигналы в один выход-
ной вектор. Сигналы объединяются в вектор сверху вниз, слева направо. 
Векторный сигнал можно подключать к виртуальному дисплею и осцил-
лографу, которые будут отображать все значения вектора (осциллограф 
будет их отобрать в одной координатной сетке) 

 

Блок демультиплексирования выделяет компоненты из входного вектора 

 

Блок селектора предназначен для выборки заданных элементов из векто-
ров или матриц. Выбор может быть задан с помощью диалогового окна 
или управляющего порта (в последнем случае у блока появляются выво-
ды для управляющих сигналов) 

 

Многопортовый переключатель обеспечивает коммутацию одного из ря-
да сигналов на выход под действием управляющего сигнала, указываю-
щего номер входного порта (начиная с 0 или с 1 по выбору). Если на 
управляющий вход подается вещественное число, то дробная часть от-
брасывается. Переключение возможно в динамике процесса моделирова-
ния, что позволяет формировать сложные последовательности сигналов 

 

Специальный случай многопортового переключателя, имеющего один 
входной и один управляющий порт. Данный блок выбирает указанный 
управляющим входом элемент входного вектора 

 

Переключатель обеспечивает коммутацию одного из двух входных сиг-
налов на выход под действием управляющего сигнала. В отличие от мно-
гопортового переключателя, в котором выход задается целым числом на 
управляющем входе, в данном блоке вход выбирается путем сравнения 
значения на управляющем входе с заданным пороговым значением (воз-
можные условия переключения на первый вход: больше либо равно за-
данному порогу, больше заданного порога, не равно 0) 

 

Блок служит для слияния двух и более сигналов в один выходной сигнал 

 

Ручной переключатель сигналов служит для подключения одного из двух 
входных сигналов на выход при ручном управлении – двойном щелчке 
левой клавиши мыши на пиктограмме переключателя. Переключение 
возможно как в процессе моделирования, так и при его остановке 

 

Блок передает сигнал одноименным блокам From. В паре с блоком From 
данный блок позволяет передавать сигнал между блоками без необходи-
мости создания между ними непосредственной связи. Блок Goto может 
передавать сигнал сразу нескольким блокам From 

 

Блок принимает сигнал от одноименного блока Goto, который рассмат-
ривается как источник сигнала. В паре с блоком Goto данный блок по-
зволяет передавать сигнал между блоками без необходимости создания 
между ними непосредственной связи. Блок From может принимать сиг-
нал только с одного блока Goto 

 

Блок задает область видимости блока Goto. Одноименный блок Goto бу-
дет видим только для блоков From, расположенных в подсистеме, в кото-
рую добавлен блок видимости и во вложенных в нее подсистемах 
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Продолжение таблицы 3 
Блок Описание 

 

Блок служит для объявления именованного хранилища данных. Храни-
лище доступно на всех уровнях иерархии модели и позволяет сохранять 
и извлекать данные в любом месте модели без необходимости их переда-
чи вверх/вниз по иерархии через входные/выходные параметры подсис-
тем 

 

Блок размещения данных в именованном хранилище 

 

Блок извлечения данных из именованного хранилища 

Таблица 4 – Блоки раздела библиотеки «Math Operations» 
Блок Описание 

 

 

Блок сложения/вычитания. Для блока можно указать количество вхо-
дов и знаки для каждого входа. Число входов и тип операции задаются 
шаблоном. Например, шаблон «++» означает, что блок имеет два сум-
мирующих входа, а «+-+», что он имеет три входа, причем средний – 
вычитающий, а крайние – суммирующие. Символ «|» в шаблоне озна-
чает увеличение расстояния между соответствующими входами. В 
случае только суммирования число входов может задаваться целым 
числом. Если блок имеет только один вход, то складываются, либо из 0 
вычитаются элементы входного вектора 

 

Блок изменения знака 

 

 

Блок умножения/деления. Для блока можно указать количество входов 
и типы операции для каждого входа. Число входов и тип операции за-
даются шаблоном. Например, шаблон «*/» означает, что блок выпол-
няет умножение 1 на первый вход и деление на второй. В случае толь-
ко умножения число входов может задаваться целым числом. Если 
блок имеет только один вход, то 1 умножается, либо делится на эле-
менты входного вектора. Помимо обычного умножения/деления можно 
выбрать матричные операции. В этом случае знак «/» в шаблоне озна-
чает обращение матрицы 

 

Блок скалярного произведения векторов 

 

Блок контроля знака возвращает –1 при отрицательном входном аргу-
менте, 0 при нулевом входном аргументе и 1 при положительном 
входном аргументе 

 

Блок вычисления абсолютного значения (модуля) числа 

 

Блок округления. Виды округления: floor – округление до ближайшего 
меньшего целого числа, ceil – округление до ближайшего большего це-
лого числа, round – округление до ближайшего целого числа, fix – це-
лая часть числа 
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Продолжение таблицы 4 
Блок Описание 

 

Блок вычисления некоторых стандартных математических функций 
(экспонента, логарифм, возведение в степень и т.д.) 

 

Блок вычисления тригонометрических функций 

 

Блок вычисления заданного полинома от входного сигнала 

 

Блок вычисления минимума/максимума по входам. Если блок имеет 
один вход, то вычисляется минимум/максимум по входному вектору 

 

Блок умножения входа на константу (константа может быть скалярным 
значением, вектором или матрицей) 

 

Блок умножения входа на скалярную константу, которая может изме-
няться в процессе моделирования c помощью полосы прокрутки 

 

Блок добавления константы (смещения) к входному сигналу 

 

Блок для вычисления модуля и аргумента комплексного числа 

 

Блок для выделения действительной и мнимой частей комплексного 
числа 

 

Блок, преобразующий модуль и аргумент в комплексное число 

 

Блок, преобразующий действительную и мнимую части в комплексное 
число 

Таблица 5 – Блоки раздела библиотеки «Logic and Bit Operations» 
Блок Описание 

 

Блок вычисления логических операций над входами. Количество входов 
задается целым числом. Входное значение считается истиной, если оно не 
равно 0, и ложью, если оно равно 0. Могут быть заданы следующие логи-
ческие операции: AND – логическое умножение (операция И); OR – логи-
ческое сложение (операция ИЛИ); NAND – операция И-НЕ; NOR – опера-
ция ИЛИ-НЕ; XOR – сложение по модулю 2 (исключающее ИЛИ); NOT – 
логическое отрицания (НЕ) 

 

Блок сравнения входных сигналов. На выходе 1, если результат сравнения 
истина, иначе 0 (ложь) 
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Продолжение таблицы 5 
Блок Описание 

 

Блок сравнения входа с заданной константой. На выходе 1, если результат 
сравнения истина, иначе 0 (ложь) 

 

Блок сравнения входа с нулем. На выходе 1, если результат сравнения ис-
тина, иначе 0 (ложь) 

 

Блок проверки на попадание входного сигнала в заданный интервал 

 

Блок выполнения побитовых логических операций 

 

Блок, обнаруживающий увеличение сигнала. Возвращает истину (1), если 
значение входного сигнала больше его предыдущего значения, иначе ложь 
(0) 

 

Блок, обнаруживающий уменьшение сигнала. Возвращает истину (1), если 
значение входного сигнала меньше его предыдущего значения, иначе ложь 
(0) 

 

Блок, обнаруживающий изменение сигнала. Возвращает истину (1), если 
значение входного сигнала не равно его предыдущему значению, иначе 
ложь (0) 

Таблица 6 – Блоки раздела библиотеки «Continuous» 
Блок Описание 

 

Блок интегрирования входных данных (сигналов). Параметры 
позволяют задать: начальное значение интегрирования (Initial 
condition) либо как внутренний параметр блока (если Initial 
condition source установлен в internal), либо как вход блока 
(если Initial condition source установлен в external); верхнюю 
(Upper saturation limit) и нижнюю (Lower saturation limit) 
границы результатов интегрирования; сброс блока в начальное 
состояние по внешнему сигналу (External reset); выход насы-
щения (Show saturation port) выдающий 1 при достижении 
верхней границы интегрирования, –1 при достижении нижней 
границы и 0, если значение интеграла находится между грани-
цами; и другие параметры 

 

Блок дифференцирования входных данных (сигналов) 

 

Блок фиксированной задержки обеспечивает временную за-
держку входного сигнала на заданное время 

     

Блок управляемой задержки имеет два входа: один – для за-
держиваемого сигнала, а другой – для сигнала управления. По-
зволяет создавать задержку, зависящую от управляющего сиг-
нала 
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Продолжение таблицы 6 
Блок Описание 

 

Блок служит для создания передаточной функции с заданными 
полюсами и нулями 

 

Блок передаточной характеристики создает передаточную 
функцию H(s) = y(s)/u(s) в виде отношения полиномов задан-
ной степени 

 

Блок задает систему линейных уравнений 

Таблица 7 – Блоки раздела библиотеки «Lookup Tables» 
Блок Описание 

 

Блок задания одномерной функции в виде таблицы значений с поддерж-
кой интерполяции между значениями 

 

Блок задания двумерной функции в виде таблицы значений с поддержкой 
интерполяции между значениями 

 

Блок задания многомерной функции в виде таблицы значений с поддерж-
кой интерполяции между значениями 

Таблица 8 – Блоки раздела библиотеки «User-Defined Functions» 
Блок Описание 

 

Блок служит для задания функций одной переменной u или ряда пере-
менных u(i). Входным сигналом блока может быть вектор с числом ком-
понентов, равным числу переменных. Функция представляет собой вы-
ражение, составленное по правилам схожим с правилами принятыми для 
описания выражений на языке C 

 

Блок служит для задания функций одной переменной u или ряда пере-
менных u(i) по правилам, принятым для языка программирования базо-
вой системы MATLAB. В частности, это означает, что в теле функции 
могут встречаться как встроенные функции системы MATLAB, так и 
любые процедуры и функции, реализованные в виде M-файлов 

 

Блок, позволяющий включать в модель S-функции. S-функции являются 
программами, написанными на языках MATLAB, C, Ада, Фортран и др., 
и представленными файлами соответствующих форматов 

Таблица 9 – Блоки раздела библиотеки «Discontinuities» 
Блок Описание 

 

Блок представляет собой нелинейное устройство – идеальный ограни-
читель, сигнал, на выходе которого равен входному сигналу до тех пор, 
пока не достигает верхнего (Upper limit) или нижнего (Lower limit) по-
рогов ограничения. После этого сигнал перестает изменяться 



17 
 

Продолжение таблицы 9 
Блок Описание 

 

То же, что и предыдущий блок, но пороги задаются с помощью отдель-
ных входов 

 

Блок генерирует нулевой выходной сигнал в пределах зоны нечувстви-
тельности (мертвой зоны), заданной верхним и нижним порогом. Если 
входной сигнал больше верхнего порога, то выходной сигнал равен 
входному сигналу минус верхний порог. Если сигнал меньше нижнего 
порога, то выходной сигнал равен входному сигналу минус нижний по-
рог 

 

То же, что и предыдущий блок, но пороги задаются с помощью отдель-
ных входов 

 

Блок ограничивает первую производную входного сигнала. Скорость 
изменения выходного сигнала не будет превышать установленного по-
рога. Производная вычисляется по формуле: 

))1()(/())1()(( −−−−= ititiyiurate , где u(i) и t(i) – текущее значе-
ние сигнала на входе и текущее время, а y(i – 1) и t(i – 1) – значение 
сигнала на выходе блока на предыдущем шаге и время предыдущего 
шага. Если rate больше чем параметр Rising slew rate (R), то на выходе 
блока формируется сигнал y(i) = Δt ⋅ R + y(i – 1). Если rate меньше чем 
параметр Falling slew rate (F), то на выходе блока формируется сигнал 
y(i) = Δt ⋅ F + y(i – 1). Если rate находится между R и F, то y(i) = u(i) 

 

То же, что и предыдущий блок, но границы скорости изменения сигнала 
задаются с помощью отдельных входов 

 

Релейный блок переключает выходной сигнал между двумя заданными 
состояниями on и off. Если на выходе on, то данное состояние сохраня-
ется до тех пор, пока входной сигнал не станет меньше значения пара-
метра Switch off point. Если на выходе off, то данное состояние сохра-
няется до тех пор, пока входной сигнал не станет больше значения па-
раметра Switch on point 

 

Блок имитирует эффект возникновения люфта, т.е. ситуацию при кото-
рой в начале движения изменения входного сигнала, не приводит к из-
менению выходного сигнала. Блок имеет два параметра: величину люф-
та Deadband width и начальный уровень сигнала на выходе Initial out-
put (расположен посередине люфта). Когда сигнал на входе начнет на-
растать, сигнал на выходе не будет изменяться, пока изменение входно-
го сигнала не достигнет верхней границы люфта. Далее выходной сиг-
нал будет изменяться пропорционально входному. Когда сигнал на вхо-
де начнет уменьшаться, сигнал на выходе не будет изменяться, пока из-
менение входного сигнала не достигнет нижней границы люфта 

 

Блок фиксирует прохождение сигналом заданного уровня (по умолча-
нию нулевого) и при каждом пересечении вырабатывает короткий им-
пульс единичной амплитуды 
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Продолжение таблицы 9 
Блок Описание 

 

Блок служит для моделирования фрикционных эффектов сухого и вяз-
кого трения 

 

Блок устанавливает выходной сигнал в ноль, если входной сигнал пре-
вышает пороговое значение, иначе выходной сигнал равен входному 

 

Блок служит для квантования меняющихся сигналов с одинаковым ша-
гом по уровню, превращая сигнал в ступенчатый. Выход блока равен: y 
= q ⋅ round(u/q), где u – значение сигнала на входе блока, а q – шаг кван-
тования 

2.4 Навигатор моделей 

Кнопкой «Launch Model Explorer»  панели инструментов окна моде-
ли можно запустить навигатор моделей (рисунок 4). Навигатор модели дает 
полную информацию обо всех блоках модели. В левой части окна навигатора 
представлено дерево открытых моделей, справа параметры модели (среди ко-
торых блоки открытых систем и подсистем). С помощью пунктов «Base 
Workspace» и «Model Workspace» можно задать переменные, используемые 
при создании моделей. 

 
Рисунок 4 — Выделение блоков модели 

2.5 Создание подсистемы 

Пакет Simulink обеспечивает создание моделей, внутри которых распо-
лагаются подсистемы (субмодели). Внутри подсистем первого уровня, в свою 
очередь, могут располагаться подсистемы второго уровня и т. д. Это напоми-
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нает ситуацию, когда сложная система набирается из отдельных систем – мо-
дулей, каждый из которых, в свою очередь, является системой или устройст-
вом. Такой принцип конструирования сложных моделей дает ряд важных 
достоинств: 

− имеется возможность разбивки решаемой задачи на ряд более мелких 
задач, решаемых подсистемами; 

− каждая подсистема может отлаживаться отдельно и использоваться в 
полной системе уже после отладки; 

− существенно упрощается вид основной модели за счет исключения 
из нее второстепенных блоков; 

− облегчается модификация полной модели за счет модификации ее 
более простых подсистем. 

2.5.1 Создание подсистемы из выделенных блоков 

Простейшим способом создания подсистемы является выделение в мо-
дели некоторого блока и превращение его в подсистему. 

Поместим ряд блоков из ранее построенной модели (рисунок 3) в от-
дельную подсистему. Для этого: 

а) выделите блоки «Saturation», «Dead Zone» и «Relay», которые необ-
ходимо поместить в подсистему (установите курсор мыши около нужной 
группы блоков. Нажав левую кнопку мыши, передвигайте мышь до тех пор, 
пока не охватите прямоугольной рамкой все выделяемые блоки (рисунок 
5 а). Отпустите левую кнопку мыши. Попавшие в прямоугольник блоки бу-
дут выделены (рисунок 5 б)). 

б) создайте подсистему, выбрав пункт меню «Edit ⇒ Create Subsystem». 
После выполнения команды «Create Subsystem» на месте выделенных блоков 
появится блок подсистемы. 

в) дважды щелкните левой кнопкой мыши на блоке подсистемы. Поя-
вится окно для просмотра или редактирования созданной подсистемы (рису-
нок 6). 

 
Состав блоков и соединений в созданной подсистеме остался таким же, 

как и в исходной модели. Основное отличие проявляется в том, что в подсис-
теме автоматически появились новые блоки – порт входа In1 и порты выхода 
Out1, Out2, Out3. Порты изображаются овалами с номером внутри и подпи-
сями. Благодаря этим портам подсистема включается в состав основной мо-
дели. Если выделенный под подсистему блок содержит несколько входов и 
выходов, то в подсистеме появятся несколько портов ввода и портов вывода. 

Порты входа служат для приема данных подсистемой, а порты выхода 
– для передачи выходных данных в основную модель (или в подсистему бо-
лее высокого уровня). Порты входа и выхода могут переименовываться поль-
зователем при условии, что их имена будут уникальными. 
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 а б 
Рисунок 5 — Выделение блоков модели 

 

 
Рисунок 6 — Модель с подсистемой 

2.5.2 Построение подсистем на основе блока SubSystem 

Создание подсистемы путем выделения ее из имеющейся модели не 
всегда удобно. Нередко предпочтительнее сначала создать подсистемы, а за-
тем уже формировать из них общую модель. Для построения моделей с под-
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системами Simulink имеет библиотеку «Ports & SubSystem». Для примера, 
построим функциональный генератор треугольных разнополярных импуль-
сов со стандартной единичной амплитудой.  

Для генерации треугольного сигнала вычтем из стандартного однопо-
лярного прямоугольного сигнала (длительность импульса и паузы равны) с 
амплитудой 4 константу, равную 2. После пропускания сигнала через инте-
гратор получим однополярный треугольный сигнал. Чтобы сделать его раз-
нополярным, надо вычесть из него константу 1. 

а) откройте окно новой модели. 
б) из раздела библиотеки «Simulink ⇒ Ports & Subsystems» перенесите 

в окно модели блок «SubSystem». 
в) дважды щелкните мышью на добавленном блоке. Откроется окно 

подсистемы. Это окно содержит лишь соединенные друг с другом блоки In1 
и Out1. 

г) выделите мышью порт In1 и соединение, уничтожьте их командой 
меню «Edit ⇒ Delete» (или клавишей клавиатуры «Delete»). 

д) постройте подсистему в соответствии с описанной выше идеей ее 
реализации. 

е) перейдите в окно основной модели и подключите к выходу подсис-
темы осциллограф. 

ж) запустите модель. 
 

Результирующая модель и результаты ее работы показаны на рисун-
ке 7. 

 
Рисунок 7 — Модель генератора треугольных импульсов 
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2.5.3 Управляемые подсистемы 

В ряде случаев подсистемы должны быть управляемыми, то есть про-
являть активность только при наличии какого-то управляющего события или 
сигнала. В Simulink для создания управляемых подсистем служат два блока, 
расположенных в разделе «Simulink ⇒ Port & Subsystems». Это блоки вклю-
чения «Enable» и триггера «Trigger» (пускового устройства). Эти блоки мож-
но размещать только в подсистемах – попытка их переноса в окно основной 
системы приводит к появлению сообщения об ошибке. 

Наличие в подсистеме указанных блоков является формальным при-
знаком отнесения ее к типу управляемых подсистем. 

В зависимости от логики работы управляемых подсистем они делятся 
на три основных типа: 

− подсистемы, управляемые блоками «Enable» (подсистемы выполня-
ются при поступлении на вход  сигнала отличного от нуля); 

− подсистемы, управляемые блоками «Trigger» (подсистемы выполня-
ются в момент изменения сигнала на триггерном вход ); 

− подсистемы, управляемые как блоками «Enable», так и блоками 
Trigger. 

 

Таблица 10 – Блоки раздела библиотеки «Ports & Subsystems» 
Блок Описание 

 
Блок для организации входов подсистемы 

 
Блок для организации выходов подсистемы 

 

Блок для создания подсистемы 

 

Блок для создания атомарной подсистемы (блок подсистемы с 
установленным параметром «Treat as atomic unit»). Если под-
система помечена как атомарная, то при необходимости полу-
чить значения выходов подсистемы вначале выполняются все 
блоки подсистемы и лишь затем продолжается выполнение 
блоков системы. Если подсистема не является атомарной, то 
блоки подсистемы рассматриваются как находящиеся на одном 
уровне иерархии с блоками системы и могут выполняться с ни-
ми вперемешку 

 

Блок подсистемы с добавленным триггерным входом 

 

Блок подсистемы с добавленным разрешающим входом 
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Продолжение таблицы 10 
Блок Описание 

 

Блок подсистемы с добавленными разрешающим и триггерным 
входами 

 
Блок, добавляющий в подсистему порт разрешения. Подсисте-
ма с таким портом выполняется только при наличии на специ-
альном управляющем разрешающего сигнала, уровень которого 
превышает ноль 

 
Блок, добавляющий в подсистему триггерный порт. Подсисте-
ма с таким портом выполняется в момент изменения сигнала на 
триггерном входе. Виды событий задаются параметром «Trigger 
type»: 
− rising – подсистема выполняется, когда управляющий сигнал 
возрастает с отрицательного значения или нуля до положитель-
ного значения (нуля, если начальное значение отрицательное); 
− falling – подсистема выполняется, когда управляющий сигнал 
спадает с положительного значения или нуля до отрицательно-
го значения (нуля, если начальное значение положительного); 
− either – подсистема выполняется, когда управляющий сигнал 
либо нарастает либо спадает 

2.6 Работа с отладчиком моделей 

Отладчик моделей обычно используется после загрузки или подготовки 
графической модели в окне моделей Simulink. Запустить отладчик можно 
тремя способами: 

− при помощи пункта меню «Tools ⇒ Simulink Debugger…»; 
− нажатием кнопки «Debug»  панели инструментов окна модели; 
− выполнением команды «sldebug» в командной строке MATLAB: 

sldebug (Имя модели). 
 
При запуске отладчика выводится окно с пустыми установками и от-

крытой вкладкой «Outputs» (Выходы). На этой вкладке размещены короткое 
приглашение к работе с отладчиком и пояснение его назначения (рисунок 8). 

Окно отладчика не имеет меню – управление им происходит только с 
помощью панели инструментов. Эта панель имеет следующие органы управ-
ления: 

− «Step into current method»  – зайти в текущий метод; 
− «Step over current method»  – пропустить текущий метод; 
− «Step out of current method»  – выйти из текущего метода; 
− «Step to first at start of next start time»  – перейти к следующему так-

ту времени; 
− «Go to start of next block method»  – перейти к началу следующего 

метода блока; 
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− «Start/Continue»  – старт/продолжение отладки; 
− «Pause»  – приостановить отладку; 
− «Stop debugging»  – завершить отладку; 
− «Break before selected block»  – установка точки прерывания перед 

выделенным блоком; 
− «Display I/O of selected block with executed»  – показывать значения 

входов/выходов выбранного блока; 
− «Display current I/O of selected block»  – показывать значения вхо-

дов/выходов текущего блока; 
− «Enable/Disable Animation»  – подключение/отключение анимации; 

− «Animation Delay»  – регулятор времени задержки 
анимации; 

− «Help»  – вызов справки по отладчику. 
 

 
Рисунок 8 — Модель генератора треугольных импульсов 

Работа с отладчиком основана на расстановке так называемых точек 
останова («break points») и точек показа («display points»). Их список форми-
руется в поле «Blocks». Чтобы включить блок в список, надо выделить его и 
нажать на панели инструментов кнопку «Break before selected block»  или 
кнопку «Display I/O of selected block with executed»  – блок будет помещен 
в список «Blocks». Для каждого блока можно задать опции останова и показа 
его выходного сигнала (установкой соответствующего флажка после имени 
блока в списке). 

При запуске модели будет происходить остановка моделирования пе-
ред каждым из блоков, включенных в список «Blocks», для которых установ-
лен флажок точки останова, и будут выводиться результаты на каждом шаге 
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для блоков, у которых установлен флажок вывода результатов. Признаком 
работы отладчика является появление в верхнем левом углу окна модели ин-
формационного сообщения, выделенного прямоугольником из пунктирных 
черных линий. При этом блок, на котором произошла остановка моделирова-
ния, указывается линией, выходящей из блока информационного сообщения 
и кончиком указывающей на блок линии (ранее блоки выделялись цветом). 
Если линия указывает на обычный блок, то она принимает вид стрелки, цвет 
которой меняется в зависимости от работы блока (например, активизации 
входного или выходного порта). Для удаления выделенных блоков из списка 
«Blocks» служит кнопка «Remove select points». Для выполнения очередного 
шага отладки следует нажать кнопку «Start/Continue»  панели инструмен-
тов.  

Помимо последовательной пошаговой отладки по списку «Blocks» 
можно воспользоваться и другими кнопками в панели инструментов. 

Если в данный момент тестируется блок, расположенный в подсистеме, 
то в информационном окне появляется информация о том, какой блок под-
системы тестируется в данный момент. На вкладке «Outputs» отражаются: 
текущее модельное время Tm, индекс контролируемого блока s:b, где s – но-
мер модели и b – номер блока; имя блока; значения его входных U[i] и вы-
ходных Y[i] параметров. Их анализ позволяет оценить корректность работы 
блока. 

Отладчик дополнительно позволяет установить различные типы точек 
останова, например безусловные и условные. Раздел окна отладчика «Break 
on condition» задает опции, обеспечивающие останов при выполнении раз-
личных условий: 

− «Zero crossing» – прохождение сигнала через нулевой уровень; 
− «Step size limited by state» – превышение допустимого значения шага; 
− «Minor time steps» – недопустимо малый шаг времени; 
− «NaN values» – появление нечисленного значения (NaN); 
− «Break at time» – остановка в заданный момент времени. 
Можно просмотреть весь цикл отладки в режиме анимации. Для этого 

достаточно активизировать кнопку «Animation»  и выставить регулятором 
(или оставить по умолчанию) скорость анимации. 

Вкладка «Sorted List» окна отладчика позволяет получить информацию 
о порядке выполнения блоков в ходе моделирования. 

Состояние отладчика на текущем шаге моделирования можно оценить 
по информации, приводимой на вкладке «Status». Это состояние оценивается 
значением текущего времени моделирования, используемой по умолчанию 
командой исполнения отладки, степенью активности команд останова и пре-
рывания, числом и характером точек прерывания и трассировки и др. 
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3 МОДЕЛЬ АНТИБЛОКИРОВОЧНОЙ 
ТОРМОЗНОЙ СИСТЕМЫ 

3.1  Силы, действующие при проскальзывании колес 

Фактическая тормозная сила на колесе автомобиля определяется отно-
шением: 
 Pк = µZк, (1) 
где Zк – опорная реакция на колесе, µ – коэффициент тормозной силы. 

Опорная реакция на оси зависит массы автомобиля, положения его 
центра масс и динамики торможения. 

Коэффициент тормозной силы определяется семейством µ(s), где s – 
полное относительное проскальзывание. На величину µ(s) влияют такие фак-
торы как: состояние дороги (профиль, свойства опорной поверхности); по-
годные условия; состояние шины; продольная скорость автомобиля; углы 
увода колес и другие. Поэтому диаграммы µ(s) задаются семейством харак-
теристик со значительной неопределенностью, и управление автомобилем 
осуществляется с учетом этой неопределенности. 

 
V
Vs s= , (2) 

где Vs – скорость проскальзывания колеса относительно дороги, V –скорость 
оси колеса (скорость движения автомобиля). Полное относительное про-
скальзывание складывается из продольного (тормозного) проскальзывания sx 
и бокового проскальзывания sy (рисунок 9): 

 22
yx sss += . (3) 

 
Рисунок 9 — Схема скоростей тормозящего колеса 

Продольное проскальзывание определяется из выражения: 

 
V

rV
V
Vs ккxxs

x
ω−== , (4) 

 xкxsx VVV += , (5) 

 xкxsx VVV += , (5) 

 ,ккxк rV ω=  (6) 
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Vy 
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β 
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где Vx – продольная скорость колеса, Vxs – скорость тормозного проскальзы-
вания, Vxs – скорость качения колеса, ωк – угловая скорость колеса, rк – ради-
ус колеса. 

Боковое проскальзывание определяется из выражения 

 δsin==
V
V

s y
x , (7) 

где Vy – боковая скорость колеса, δ – угол бокового увода. 
Величину µ(s) можно представить в виде: 

 )()( max sfs μμ = , (10) 

где µmax – коэффициент трения для пары колесо-дорога (для сухого асфальта 
~ 0,8, для льда ~ 0,2); f(s) – функция проскальзывания, максимум которой ра-
вен 1. 

Коэффициент тормозной силы определяется выражением: 

 βμμμ cos)()( ss
s
sx

x == . (11) 

Коэффициент боковой силы определяется выражением: 

 βμμμ sin)()( ss
s
sy

y == . (12) 

Для учета изменения характеристик проскальзывания шины по направ-
лению можно использовать две исходные функции проскальзывания – функ-
цию fx(sx), полученную при прямолинейном движении колеса с тормозным 
проскальзыванием, и функцию fy(sy), полученную при движении с уводом без 
торможения. 

Предполагая по аналогии с эллипсом трения, что коэффициенты каса-
тельной силы изменяются по эллиптическому закону в зависимости от на-
правления вектора общего проскальзывания, можно записать: 
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где µx0 – коэффициент тормозной силы, который можно реализовать, если 
вектор общего проскальзывания совпадает с вектором тормозного проскаль-
зывания: 
 xxx fmax0 μμ = , (14) 

где µy0 – коэффициент боковой силы, который можно реализовать, если име-
ет место только боковой увод без торможения: 
 yyy fmax0 μμ = . (15) 

Отсюда получаем: 
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Функции проскальзывания в первом приближении можно аппроксими-
ровать выражениями: 
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где a1 = 0,79; b1 = 1,0; c1 = –0,0145; d1 = 0,00526; k1 = 1,82; a2 = 0,82; b1 = 1,0; 
c1 = –0,021; d1 = 0,004; k1 = 1,87. 

3.2 Уравнение движения автомобиля 

Дифференциальное уравнение движения автомобиля при торможении 
имеет следующий вид: 
 ( ) etwf PPPPPPmdtdV +++++=⋅⋅− Тαδ , (21) 

где V – скорость автомобиля, м/c; 
 m – фактическая масса автомобиля, кг; 
 δ – коэффициент учета вращающихся масс; 
 αP  – сила сопротивления подъему, Н; 
 fP  – сила сопротивления качению колес, Н; 
 wP  – сила сопротивления воздуха, Н; 
 tP  – сила сопротивления, создаваемая трансмиссией, Н; 
 ТP  – фактическая тормозная сила, Н; 
 eP  – сила сопротивления, создаваемая двигателем, Н. 

При торможении по ровной дороге с отсоединенным двигателем с уче-
том основных действующих сил уравнение движения можно перезаписать в 
упрощенном виде: 
 ( ) ТPPmdtdV w +=⋅− . (22) 

Сила сопротивления воздуха wP  равна 

 2)( вавw VVHBkkP +⋅⋅⋅⋅= , (23) 
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где kв – приведенный коэффициент сопротивления воздуха, H⋅c2/м4 (для ав-
томобилей категории M1 примерно 0,2; категорий М2 и М3 — 0,5 и категорий 
N1 – N3 — 0,6); 
 kа – коэффициент заполнения, рассчитанный по габаритам лобовой 
площади (для автомобилей категории M1 примерно 0,8, для остальных кате-
горий 0,85); 
 В – габаритная ширина автомобиля, м; 
 Н – габаритная высота автомобиля, м; 
 Vв – скорость ветра в направлении дороги, м/с (примем равной нулю). 

Таким образом, замедление автомобиля при торможении рабочей тор-
мозной системой с отсоединенным двигателем j, м/с2, упрощенно определя-
ется по формуле 

 
m

PPj w Т+
= . (24) 

3.3 Уравнение вращательного движения колеса 

В дальнейшем для простоты будем считать, что угол бокового увода 
колеса δ равен 0. В этом случае уравнение изменения момента количества 
движения описывающее вращательное движение колеса задается формулой: 
 ктмккк rPPdtdJ )( −=ω , (25) 

где ωк – угловая скорость колеса, рад/c; 
 N – количество колес автомобиля; 
 J – момент инерции колеса, кг⋅м2; 
 Pк – фактическая тормозная сила на колесе; 
 Pтмк – тормозная сила на колесе, развиваемая тормозным механиз-
мом, Н; 
 rк – радиус колеса, м. 

Фактическая тормозная сила автомобиля равна 

 ∑
=

=
N

i
кiPP

1
Т , (26) 

где N – количество колес автомобиля; 
Pкi – фактическая тормозная сила на i-м колесе. 
Для простоты предположим равенство опорных реакций и коэффици-

ентов сцепления на колесах (в действительности оперная реакция на колесе 
зависит от распределения массы и интенсивности замедления), тогда можно 
записать: 
 кNPP =Т , (27) 

 NmgsZsP кк /)()( μμ == , (28) 

где g – ускорение свободного падения (9,8 м/c2). 
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3.4 Модель тормозной системы 

Пневматическая тормозная система, (рисунок 10) имеет резервуары 
двух типов: центральный резервуар (ресивер) и рабочие тормозные цилинд-
ры. К каждому рабочему цилиндру ведет два трубопровода: один (1) ведет из 
центрального резервуара в тормозной цилиндр, а другой (2) из тормозного 
цилиндра в атмосферу. 

Рассмотрим систему, в которой установлен один клапан, который от-
крывает и закрывает попеременно каждый трубопровод. Когда (1) открыт – 
(2) закрыт (заполнение) и когда (1) закрыт – (2) открыт (выпуск). 

 
Рисунок 10 — Модель тормозной системы 

Тормозную силу, развиваемую тормозным механизмом на колесе, 
можно считать пропорциональной давлению в тормозном цилиндре: 
 )( атмцтмк ppCP −⋅= , (29)  

где С – коэффициент, учитывающий особенности конструкции тормозного 
механизма и его конструкцию (например, для автомобиля ЗИЛ-130 для колес 
передней оси С = 0,02525 м2, для колес задней оси С = 0,0205 м2); 

pц – давление в тормозном цилиндре; 
pатм – атмосферное давление (98 кПа). 
При заполнении: 

 vdtdpц =/ , (30) 

при выпуске: 
 vdtdpц −=/ , (31) 

где v – скорость изменения давления рабочей среды в тормозных цилиндрах 
(для пневматического привода v ≈ 300 …1500 кПа/с, меньшие значения отно-
сятся к прицепам автопоездов). 

Давление в тормозном цилиндре изменяется от атмосферного до дав-
ления в ресивере (для автомобиля ЗИЛ-310 pр ≈ 700 кПа). 

3.5 Цикл работы АБС 

Когда водитель нажимает педаль, тормозная система с АБС начинает 
работать как обычная тормозная система до тех пор, пока не возникает опас-
ность блокировки колеса. В принципе датчики должны быть способными 
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оценить угловую скорость колеса и продольную скорость автомобиля, то 
есть, получить информацию о проскальзывании, но, оценить продольную 
скорость трудно. 

Упрощенно цикл работы АБС состоит из двух процессов: заполнение и 
выпуск (торможение и растормаживание). 
Заполнение: водитель нажимает педаль и тормозной клапан открывается. 

Воздух проходит из главного резервуара в тормозной цилиндр. Вследст-
вие этого давление в тормозном цилиндре возрастает, тормозной диск 
прижимается к ободу и момент торможения также возрастает. Продоль-
ная контактная сила возрастает и приближается к максимальному зна-
чению. 

Выпуск: когда система обнаруживает, что существует опасность блокировки 
колеса, она переключает тормозной клапан. Воздух в тормозном цилин-
дре выпускается в атмосферу, давление воздуха уменьшается до значе-
ния атмосферного давления. Тормозной диск отпускается и тормозной 
момент уменьшается. Колесо свободно вращается, и продольная кон-
тактная сила также уменьшается, в результате колесо не блокируется. 
Угловая скорость вращения колеса возрастает, так как нет сил, препят-
ствующих вращению колеса. 
 
Предложено большое количество методов управления АБС. Одним из 

простейших является режим с переключениями. 
Локальной целью АБС можно считать удержание динамики каждого 

колеса вокруг максимального значения µmax. Этому значению соответствует 
величина проскальзывания s*. 

Управление заключается в переключении клапана тормозной системы 
при отклонении величины проскальзывания от заданного значения s*.  

Переключение выполняется в соответствии с правилом: 
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U  (32) 

 dtdEES slipslipslide /λ+= , (33)  

 *ssEslip −= . (34)  

Если U принимает значение 1, то клапан переключает тормозную сис-
тему в режим торможения, иначе в режим растормаживания. 

3.6 Параметры модели 

Для построения модели примем следующие параметры (в скобка при-
ведены обозначения значений, использованные в дальнейшем при построе-
нии Simulink модели): 

− коэффициент трения для пары колесо-дорога µmax =0,8 (mu_max); 
− фактическая масса автомобиля m = 8000 кг; 
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− ускорение свободного падения g = 9,8 м/c2 (g); 
− количество колес автомобиля N = 6; 
− атмосферное давление pатм = 98 кПа (p_atm); 
− давления в ресивере pр = 700 кПа (p_resiver); 
− коэффициент, учитывающий особенности конструкции тормозного 

механизма и его конструкцию С = 0,023 м2 (C); 
− скорость изменения давления рабочей среды в тормозных цилиндрах 

v =1300 кПа/с (v); 
− скорость автомобиля перед торможением V = 14 м/c (V); 
− радиус колеса rк = 0,5 м (r); 
− момент инерции колеса J = 13,8 кг⋅м2 (J); 
− приведенный коэффициент сопротивления воздуха kв = 0,6 H⋅c2/м4 

(k_v); 
− коэффициент заполнения, рассчитанный по габаритам лобовой пло-

щади kа = 0,85 (k_a); 
− габаритная ширина автомобиля В = 2,5 м (B); 
− габаритная высота автомобиля Н = 2,4 м (H). 

3.7 Модель Simulink 

На основании разработанной математической модели торможения соз-
дадим Simulink модель. 

Для простоты предположим: 
− равенство опорных реакций и коэффициентов сцепления на колесах; 
− одинаковые максимальные усилия, развиваемые тормозным меха-

низмом на передних и задних осях; 
− торможение происходит по прямой (отсутствие боковых уводов ко-

лес); 
− известна текущая продольная скорость автомобиля. 
В навигаторе моделей в рабочем пространстве введем параметры моде-

ли (рисунок 11). 
На основании формул (14) и (19) создадим подсистему «mu» расчета 

коэффициента тормозной силы (рисунок 12). 
На основании формулы (28) и используя подсистему «mu» создадим 

подсистему «wheel road friction force» расчета фактической тормозной силы 
на колесе (рисунок 13). 

На основании формул (30) и (31) создадим подсистему «Pneumatic cy-
linder» расчета давления в тормозном цилиндре колеса (рисунок 14). Значе-
ние на управляющем входе «Control» равное «1» означает переключение кла-
пана в режим заполнения, а «–1» в режим выпуска. Интегратор («Integrator») 
имеет начальное значение равное «p_atm» (атмосферное давление и ограни-
чен сверху давлением в ресивере, а снизу атмосферным давлением. 
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Рисунок 11 — Параметры модели 

 
Рисунок 12 – Подсистема «mu» расчета коэффициента тормозной силы 

 
Рисунок 13 — Подсистема «wheel road friction force» расчета 

фактической тормозной силы на колесе 

 
Рисунок 14 — Подсистема «Pneumatic cylinder» расчета давления 

в тормозном цилиндре колеса 

На основании формулы (29) и используя подсистему «Pneumatic cylind-
er» создадим подсистему «wheel breaking force» расчета тормозной силы, раз-
виваемой тормозным механизмом на колесе (рисунок 15). 
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Рисунок 15 — Подсистема «wheel breaking force» расчета тормозной 

силы, развиваемой тормозным механизмом на колесе 

На основании формулы (25) создадим подсистему «wheel angular ve-
locity» расчета угловой скорости колеса (рисунок 16). Интегратор 
(«Integrator») имеет начальное значение равное «V/r» (начальная скорость ав-
томобиля, деленная на радиус колеса) и ограничен сверху бесконечностью, а 
снизу 0. 

 
Рисунок 16 — Подсистема «wheel angular velocity» расчета 

угловой скорости колеса 

На основании формул (32), (33) и (34) создадим подсистему «Control 
Subsystem» управления АБС (рисунок 17). Величину s* примем равной 0,2, а 
λ равной 0,0001. 

 
Рисунок 17 — Подсистема «Control Subsystem» управления АБС 

На основании формул (4), (22), (23) и (27), используя ранее созданные 
подсистемы, создадим модель тормозной системы с АБС (рисунок 18). Руч-
ной переключатель («Manual Switch») переключает систему на торможение с 
АБС и без АБС. Интегратор расчета скорости («Speed integrator») имеет на-
чальное значение равное «V» (начальная скорость автомобиля), ограничен 
сверху величиной «V*2» (любая скорость больше начальной), снизу 0 и име-
ем установленный выход насыщения (Show saturation port) для остановки мо-
делирования. Блок «Stop Simulation» останавливает моделирование при дос-
тижении нулевой скорости. Интегратор расчета дистанции торможения име-
ет начальное значение равное 0. 

В параметрах моделирования (команда меню «Simulation ⇒ Simulation 
Parameters…») на вкладке «Solver» начальное время моделирования «Start 
time» устанавливается в 0, конечное время «Stop time» устанавливается в 
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«inf», тип решения «Type» в «Variable-step» и метод решения «Solver» в 
«ode23s (stif/Mod. Rosenbrock)».  

Результаты моделирования приведены на рисунке 19. На графиках: 
сверху — скорость автомобиля и линейная скорость колеса, в середине — 
величина проскальзывания колеса, снизу — команды системы управления 
(для торможения без АБС не имеет смысла). 

 
Рисунок 18 — Модель тормозной системы с АБС 

    
Рисунок 19 — Результаты моделирования торможения с АБС (слева) – 
тормозной путь 15,16 м и без АБС (справа) – тормозной путь 17,24 м 
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